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Analise Espacial

Ponto crucial de um SIG!!!

Inclui transformacodes, manipula¢des e
metodos que podem ser aplicados aos dados
geograficos para adicionar valor a eles, apoiar

decisbes e revelar padrdoes e anomalias que
Nao sao Obvios a primeira vista



Analise Espacial

= E o processo pelo qual transformamos dados
brutos em informacao util na busca pela
descoberta cientifica ou por uma tomada de
decisao mais eficiente.

= Abrange um conjunto de métodos cujos resultados
mudam quando muda a localiza¢ao dos objetos em
analise.



Analises Baseadas na Localizacao

= Comparacao entre diferentes propriedades do
mesmo lugar

1. Analise de Tabelas de Atributos: compara o
conteudo de uma ou mais colunas da tabela

= Estatisticas

= Graficos de dispersao

= Andlises de regressao/ regressao espacial (tema para o
curso de métodos e técnicas de andlise da informacao!)



Importar os dados sobre empreendimentos residenciais
lancados entre 1985 e 2013
(LanRes_85_13 RMSP_CEM_SIRGAS2000_UTM23S)




Estatisticas

Vector > Analysis Tools > Basic Statistics for Fields

Vetor Raster Banco de Dados

Geoprocessamento
Geometrias
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wr

i

r

—r—Eer

e
t Bl

W

L= IR

i3
W

! :-:."'j EE '.!-.

Web Malha Processamento

L OS @K

g "

A

i_.'-.l_l.

Contagem de pontos em poligono...

Intersegoes de linhas...

Coordenada(s) media(s)...

Analise de vizinhos mais proximeos...

5oma compnmentos de linha...

Campo para estatistica basica...



Estatisticas

Vector > Analysis Tools > Basic Statistics for Fields

Verificar estatisticas basicas da variavel “preco atualizado do m? da
area atil” (pc_au_atu)

s Campo para estatistica basica

Parametros Log

Camada de entrada
LanRes_85_13_RMSP_CEM_SIRGAS2000_UTM235 [EPSG:319¢ v [[5) ﬁ

i =
= = o = s =
-'._-ll\_ TE' e _-\_'-\_E' E'-\_ L gl TE'

Campo para calcular as estatisticas
1.2PC_AU_ATU

Estatisticas [opconal]

C: fufabc/Dados_AnaliseEspadal fpreco.himl




Estatisticas

(& &

Results Viewer

() Basic Statistics for Fields

iz 2. Statistics [03:31:44PM]

Parameters Leg

processing 33e55c1d68094452a2129320£50e2a41/3clbbTe | =
7d&85546d4a0c5154134a5d0be/OUTEUT_HIML FILE.html',
'REANGE': 9390.7899393959393,

'STD DEV': 1304.713335568le3¢,

"SUM': &6481720.2&000015,
'THIRDQUARTILE': 5527.73,
'ONIQUE': 14753}

Loading resulting layers
Algorithm ‘Basic statistics for fields' finished
HTML output has been generated by this algorithm.

| 0%

Run as Batch Process...

Open the results dialog to chedk it =

Basic statistics for fields

This algorithm generates basic statistics from the
analysis of & values in a field in the attribute table
of a vector layer. Mumeric, date, time and string
fields are supported.

The statistics returned will depend on the field
type.

Statistics are generated as an HTML file,

File path: C:\Users\laboratoriol

PGT\AppData'Local\Temp'\processing 33e55c1da8c944aas:

2129320502 2341\9c 1bb7c7d59546d4a0c5 154 134a5d0bck

DUTPUT _HTML_FILE.htmk

ncel

0
[

Run Close Help

= el

Os resultados sao gerados em um arquivo .html. Para visualizar,

clique no link.



Estatisticas

Campo analisado: PC_AU ATU

Contagem: 16935

Valores unicos: 16490

Valores NULL (perdidos): 0

Valor mimimo: 944.15

Valor maximo: 43430.88

Intervalo: 42486.729999999996

Soma: 95509272 58999962

Valor médio: 5639.756279303196

Valor da mediana: 4991.33

Desvio padrao: 2935.152070320759
Coeficiente de Variagdo: 0.5204395234404355
Minorna (valor de ocorréncia mais rara): 944 15
Maioria (valor mais frequente): 2895 17
Primeiro quartil: 3669 005

Terceiro quartil: 6778.325000000001

Intervalo interquartil (IQR): 3109 3200000000006



Estatisticas por Categorias

Caixa de Ferramentas de Processamento >
Estatisticas por Categoria

Quantos empreendimentos residenciais por distrito? (COUNT)

Qual a média do preco por m? destes empreendimentos em cada
distrito? (AVERAGE)

Caixa de Ferramentas de Processamento E b 4

e & y | =

-

Estatisticas por categoria
W 0 Analise raster
Estatisticas zonais da camada raster

W ) Analise vetonal

> Estatisticas por categoria




Estatisticas por Categorias |« ===

Caixa de Ferramentas de Processamento > Parmetros || lag
v é ] O |: tE .
Estatisticas por Categoria 4| Campofs) com categorias

o Estatisticas por categoria (] TIPO_EMP

[ ] MES_LAN
[] ANO_LAN
[] DATA_ENT

Camada de vetor de entrada DIST

Parametros Log

LanRes 85 13 RMSP CEM SIRGAS2000 LTM23S [EPSG:3198 ~ 1 % -

Apenas feic

[ ]

= Sl ==
-\_E 5-\_ o LW ‘._-\.‘._E

Campo onde calcular as estatisticas (se deixado vazio, apenas a contagem € calculada) [opcional]

1.2 PC_ALJ_ATU w

Campo(s) com categorias

~TCT
1
LAl

Estatisticas por categoria

C: fufabc/Dados_AnaliseEspadial fjpreco_distrito.ods




Estatisticas por Categorias

o
N @7

ﬁma’

N |
|®eV./m il

Layers 3
« @l ® T & - & @ Ly

Statistics by category
v @ LanRes_8513_RMSP.C

10
1
12
13
14
15
16
17
18
19
120

= 4
Q. Type to locate (38K)

[ |
'

DIST
MOEMA

JABAQUARA
CAMPO BELO

ITAIM BIBI

VILA LEOPOL...

JAGUARE
BUTANTA

RIO PEQUENO
PINHEIROS
PIRITUBA
JAGUARA
SAQO DOMIN...
JARDIM PAU...
PERDIZES
LAPA

ALTO DE PIN...

RAPOSO TAV...

CAPAQO REDOQ...

CAMPO LIMPO

E | ? Show All Features

count

567
360
322
639
142
57
14
217
272

105

59
342
458
230
158

74

56

3701

129

£
unigque

565
358
318
637
139
56
12
214
269
101
10
59
339
455
229
154
73
56
3607

128

Statistics by category :: Features Total: 93, Filtered: 93, Selected: 0

) Y e 1-:1- d‘

min

2924.04
1806.93
2740.77
3569.71
3266.98
232734
2097.28
2026.14
3688.88
1761.55
2412.82
1828.81
2854.88
2782.41
3026.13
3413.7
1716.75
1495.5
94415

1496.06

max

2979113
11878.03
20280.65
29863.84
11459.65
8093.08
13542.3
10702.66
24883.55
10407.45
7052.45
7491.99
27953.39
16399.51
12255.34
15622.68
833013
5134.68
20435.51

6973.35

range

26867.09
100711
17539.88
2629413
8192.67
5765.74
11445.01999...
8676.52
21194.67
8645.90000...
4639.62999...
5663.18
25098.51
13617.09999...
9229.21
12208.98
6613.379999...
3639.180000...
19491.35999...

5477.290000...

sum

5331610.549...
2011695.460...
2412211.079...
6039916.899...
794308.800...
257733.54
556392.250...
955522.630...
2477767.498...
421260.7399...
45590.41
259035.1899...
3523993.78...
3285835.50...
1491345.490...
1230364.229...
281449.9300...
178115.8599...
14611669.98...

444193.8200...

mean

9403.193209...
5588.04294...
7491.338757...

9452.139123...
5503.72394...

4521.641052...

4880.633771...
4403.33009...

9109.439338...

4012.007047...
4559.041
4390.42694...

10304.07538...
7174.313340...

6484.110826...

7787.1153797...

3803.377432...

3180.640357...

3948.032961...

3443.36294...

median

8488.89
5317.605
6973.25
8624.25
5148.745000...
4252.89
4852.035
4175.64
8213.01
3600.58
4247.71
38561.78
9243.00500...
6600.99
5871.81
7267.58
3479.89000...
3229.1
3711.68

31025

stddev
3791.311224...

1835.299144...
2595.94933...
3814.195973...
1462.001216...
1317.2736921...
1990.231835...
1345.548001...
3601.5641438...
1613.414840...
1757.521007...
1427.4790089...
4538.179873...
2350.207489...
2192.680960...
2330.33563...
1314.1115694...
936.606344...
1636.077410...

1196.734250...



Graficos de Dispersao

(Scatter plot)

Diagramas de dispersao que mostram correlagao

hegativa entre as variaveis

Correlacao fraca

Correlagao forte

Correlacao perfeita




Graficos de Dispersao (Scatter plot)

Caixa de ferramentas de processamento >
Grafico de dispersao da camada vetorial

‘o Grafico de dispersdo da camada vetorial

Parametros Log

Camada de entrada

LanRes_85_13 RMSP_CEM_SIRGAS2000_UTM235 [EPSG: 3198 I_-"_Eﬂ:r_l % =L

- -
Apenas fe COESs SeIedondadas

Atributo ¥
1.2 PC_AL_ATU w
Atributo ¥

1.2 REMRESP10 hd

Grafico de dispersdo

C: fufabc/Dados_AnaliseEspadal fpreco_renda.htmi G




Graficos de Dispersao

(Scatter plot)

Results Viewer [

Scatterplot [03:54:19PM]
7, Statistics [03:31:44PM]

10k

8k

File path: C:\sersiLaboratoriol .. 2
PET\WAppDataLocal Temp'\processing_33e55c1d63c944a:

822129320150 2a41\2c 74ffbab42d4802bf6 22cd 264944
df2YOUTPUT. himl: -

5k

10k

15k

20k

25k

30k



Analise de Regressao

Ferramenta estatistica que utiliza a relagao entre duas ou
mais variaveis tal que uma variavel possa ser explicada
(variavel resposta/ dependente) pela outra ou outras
(variaveis indicadoras/ preditoras/ explicativas/
independentes).

Tema para o curso de

Y - aX + b métodos e técnicas de

andlise da informacao!

= Criminalidade (+) X Renda (-), Investimentos (-)
- Longevidade (+) X Escolaridade (+), Renda (+)

NETER J. et al. Applied Linear Statistical Models. Boston, MA: McGraw-Hill, 1996.



Juncao Espacial

1. Operacao ponto em poligono

Compara as propriedades dos pontos com as das areas onde
estao contidos

2. Sobreposicao de feicoes/areas

Permite determinar se duas areas se sobrepde, determinar a
area de sobreposicao e definir a area formada pela
sobreposicao



Operacao Ponto em Poligono

Compara as propriedades dos pontos com as das
areas onde estdo contidos

Quantas ocorréncias (de deslizamento/ criminalidade, etc.) em
cada bairro?

Dinamica Imobiliaria:
Quantos lancamentos imobilidrios (ponto) em cada municipio
da RMSP?



Operacao Ponto em Poligono

Importar o
shapefile
“MUNICIPIOS_RMSP_SIRGAS2000”




Operacao Ponto em Poligono

Vetor > Analisar > Contagem de Pontos em Poligonos

Vetor Raster BancodeDadeos Web Malha Processamento Ajuda

b M < &
Geoprocessamento L D L) R E 50
- L - : - :
Geometrias o

Analisar » “4% Contagem de pontos em poligono..,



(2} Contagem de pentos em poligono

Parametros Log

Poligonos

|~ MUNICIPIOS _RMSP_SIRGAS2000 [EPSG:31983) &@ ﬁ S

Apenas feicoes selecdonadas

Pontos

LanRes 85 13 RMSP_CEM_SIRGAS2000 UTM23S [EPSG:3198 &@ % -

Apenas feicoes selecionadas

Campo de peso [opconal]
Campo da dasse [opcional]

Mome do campo de contagem

MUMPOINTS

Contagem
C: fufabc/Dados_AnaliseEspadal (contagem. shp €3 B




Operacao Ponto em Poligono

Camadas E b 4
o [l ® T &~ & O
contagem 1 P

N e 4) Aproximar para camadals)
= preco_distrito P g

© LanRes 853

. MUNICIPIC D‘: Mostrar na vista geral
Mostrar contagemn dos elementos

= Mostrar etiquetas

Aproximar a Selecdo

Copiar camada

"1}&!}@55’5?{&5"%5‘5

hd Renocmear Camada
L] Duplicar Camada
|1. Remover Camada...
[ W Mover para inferior
7
i - ~ Abrir tabela de atributos

Novo Layer terd uma coluna com a contagem dos pontos por poligono



Operacao Ponto em Poligono

L contagem — Total de feigdes: 39, Filtrado: 39, Selecionado: 0

v - & e T BE & # |
|0 CD_GEOCODM MM_MUMNICIP MUMPOINTS
1 1771 3503901 ARUJAFA", 11,00000000000...
2 1791 3505703 EARLERI 278,0000000000..,
3 1807 3506607 EIRITIEA-MIEIM 0
4 1828 3509007 CAIEIRAS 1,000000000000...
3 1830 3509205 CAJAMAR 39,00000000000...
b 1848 3510609 CARAPICUAFARERA 58,00000000000..,
[} 1871 3513009 COTIA 219, 0000000000...
g 1879 3513801 DIADEMA 103, 0000000000,
g 1894 3515004 EMEL 13,00000000000...

Novo Layer terd uma coluna com a contagem dos pontos por poligono



Operacao Ponto em Poligono

= Caixa de Ferramentas de Processamento ->
v.vect.stats (GRASS)

Camxa de Ferramentas de Processamento

#&ﬂ +

w i i &

v.vect.stats

-} Usado recentemente
v g GRASS
v Vector (v.™)
@ v.vect.stats




Operacao
Ponto em
Poligono

L) vvect.stats

Parametros Log

Mame of existing vector map with points

atributos_|ocalizacao [EPSG:31983]

Apenas feicies seleconadas
Mame of existing vector map with areas

|~ MUMICIPIOS_RMSP_SIRGAS2000 [EPSG:31983]

Apenas feicdes selecionadas
Input feature type
point
Method for aggregate statistics

dverage

Column name of points map to use for statistics

1.2pC_AU_ATU

Column name to upload points count (integer, created if doesn't exists)

contagem

Column name to upload statistics (double, created if doesn't exists)

media

P Parametros avancados

Updated

C:fufabc/Dados_AnaliseEspadal fpreco_munidpio.shp




Operacao Ponto em Poligono

Camadas E W

“ m @'IT;E”Ti_fIl
‘ preco municipio

............................................................ ...-I’L'I EFJFD:-:irTIElr |;:IEIrE| Camﬂdﬂi'&]

®  atributos_localizas
|:| ® diferenca

Aproximar a Selecdo

] . intersecao “i; Mostrar na vista geral
[1 ® recortado Mostrar contagem dos elementos
(] Il ABC sP #1  Mostrar gtiquetas
ABEC_MUNICIPIO. Copiar camada
MUNICIPIO_5P Renomear Camada

. bairros ABC

ABC SETORES CE —
[] B reclassificacao [l Remover Camada...
] B morros

[ 1 #® MDE SBC_SIRGAS

[] B Declividade SBC Abrir tabela de atributos

L1000 O

Duplicar Camada

Mower para _inferior




Operacao Ponto em Poligono

) preco_municipio — Total de feigdes: 460, Filtrado: 460, Selecionado: 0 — O
J 4 g LT E D ¥ E = & &
cat |0 CD GEQCODM MM MUMNICIP contagem media
1 24 2114 3534401 OSASCO 239 4490 867531380...
2 2 1791 3505708 BEARUERI 278 49530,025215827...
3 24 2114 3334401 OSASCO 239 4490 367531380...
4 19 2010 3525003 JANDIRA 25 2737 626400000...
5 2 1791 3505708 BARUERI 278 4930,025215827...
b 19 2010 3525003 JANDIRA 23 2737 626400000...
7 17 1984 3522505 ITAPEVI 7 2726,022857142...
8 2 1791 3505708 BARUERI 278 4950,025215827...
g 17 1984 3522505 ITAPEVI 7 2726,022857142...



Sobreposicao de Feicoes

Permite determinar se duas areas se sobrepoe,
determinar a area de sobreposicao e definir a area
formada pela sobreposicao

Quais sdo as dreas de alta altitude e alta declividade?

Qual a intersecdo entre dreas construidas/desmatadas e dreas de
preservacdo? Qual a dimensdo desta drea conflituosa?

Pode envolver dados vetoriais ou matriciais, mas assume uma
perspectiva diferente em cada caso. Para dados matriciais,
envolve andlises célula-a-célula.



Dados Matriciais
= Operac¢des de sobreposicdao sao mais simples

= Atributos de diferentes matrizes poder ser
rapidamente combinados

8- Nala Raster calculator

| Rasler bands Result layer

‘“Calculadora Raster”’

Dudput layer

| Curren layer extent

| X rin 0L00000 2 XMax 000000
Y min L0000 Y max 000000
Columng o :| Pows o
Output format GeaTIFF
w Add result io project
‘ Opara
sqrt Sin . aoos
i atan
== == AND

Raster calculalor expression




Calculadora Raster: Exemplo de Aplicacdo

Modelo Digital de Terreno (MTD)

\

¥
m _ Produtos gerados na aula de
Modelagem Numérica de Terreno (MNT)
¥

Tabela 1 - Padries de relevo e pardimetros basicos.

Amplitude Declividade predominante
Padrao de relevo
predominante (m) (%) (Graus)
Planicies < 20 Da3 0al?
Terracos < 20 a6 1.7a34
Colina 20a70 <20 <113
Morrotes baixos 20 a 60 =20 >11.3
Morrotes altos 60 a 90 20a30 11.3a16.7
Morros baixos 60 a 90 =130 >16.7
Morros altos =90 > 30 >16.7




Calculadora Raster: Exemplo de Aplicacdo

Importar arquivos:
MDE_SBC_SIRGAS2000 UTM23S & Declividade_SBC

=" MDE_SBC_SIRGAS2000_UTM23S " Declividade_SBC
Il 10153 Ho
935.675 109.744

Valores de altitude (em metros) Valores de declividade (em porcentagem)



Calculadora Raster:
Algebra de mapas
& Reclassificacao

Raster Banco de Dado
& ﬁ Calculadora Raster,

=

Encontrar areas
com:

Elevacdo > 780
AND
Declividade > 20%

o) Calculadora raster

Bandas raster

Declividade_SBC@1

MDE_SBC_5IRGAS2000_LTMZ235@1

¥ Operadores

+ s
- /
= F
o= ==

Calculadora de expressao raster

Camada resultado

[] Criar matriz em tempo real em vez de gravar camada no disco

Camada de =aida ic'l,Dadns_.ﬁ.naliseEspacial'|,m|:|rr|:|5.ﬁf

Formato de saida | GeoTIFF e

Extensdo Espacial

Usar a extensdo da camada seledonada

Xmin [331493,42202 3| Xmax |356580,78046 |3 |

Ymin [7348448,78939 |3] Y max |7384792,33006 |3

Resolucdo

Colunas m Linhas |1173 =

SRC de saida EPSG:31983 - SIRGAS 2000 [UTM zo1 ~ || &5

Adicionar resultado ao projeto

mir IF Cos A0S

max AND sin asin

abs OR tan atan
& sqrt log10 In

"Declividade SBC@1™ > 20 AND "MDE_SBC_SIRGAS2000 UTM235@1" > TEI:I|




Calculadora Raster:
Algebra de mapas & Reclassificacdo

Encontrar areas com
(elevacao >780m) E

(declividade > 20%)

Células
dentro deste critério =1,
fora do critério=0

=
g MOrTos

0
1



O
Calculadora Raster:

, Bandas raster Camada resultado
Algebra de mapaS Declividade_SBC@1 [_] Criar matriz em tempo real em vez de gravar camada no disco
oo ~ MDE_SBC_SIRGASZ000_UTMZIS@ : ! : ) _
& ReCIBSSIflcagaO monos@1 Camada de saida Is_AnahseEspau:laI'n,redasmﬁcan:an.hf
Formato de saida | GeoTIFF o

Extensao Espacial

Usar a extensdo da camada selecionada

Xmin (331493,42202 3| Xmax |356590,73046 |3 |

RECLASSIFICACAO Ymin 7348448,78939 3| Ymax |7384792,33006 |%]

Resolucdo

DECLIVIDADE =< 30% = ot Coras [s99 _[+] lnhas [1173 2]

SRC de saida EPSG:31983 - SIRGAS 2000 /UTM zor ~ | &

Adidonar resultade ao projeto

Demais valores = 0 (zero)

w Operadores

+ = { min IF cos aC0s

- / ) max AND sin asin

< = = abs OR. tan atan
L= == I= = sqrt log10 In

Calculadora de expressdo raster

"Declividade SBCRL™ <= 30




@ Propriedades da camada — reclassificacac — Simbologia

¥ Renderizacdo da banda

Tipo de renderizacdo | Banda simples falsa-cor W

Banda Banda 1 (Gray) =

Min a Max 1

b Configuracies de Valor Min / Max

Interpolar Método Exato e

Gradiente de cores _ _ |T

Sufixo da unidade rotulada

Precisdo do rétulo 4 &8 =
Valor = Cor Rotulo

0 0,0000

1 0000
Modao |Intervalo igual - Classes |2 =

Classificar l:',-:,l'-il = | | g Ed Configuracdes da Legenda. ..



Calculadora Raster:
Algebra de mapas & Reclassificacdo

Caixa de Ferramentas de Processamento ->

Reclassificar por tabela

Camxa de Ferramentas de Processamento

¥ A ( *

.

reclassificar
W ) Analise raster
Reclassificar por camada

Reclassificar por tabela



Calculadora
Raster:
Algebra de
mapas &
Reclassificacao

(2} Reclassificar por tabela

Parametros Log

Camada raster
" Dedividade_SBC [EPSG:319583]
Mamero da banda

Banda 1 (Gray)

Tabela de recassificacdo
Tabela fixa (3x3)
¥ Parametros avancados

Salda sem valores de dados

-9999 000000 =
Intervalos limites
min < valor <= max o
[ ] N30 usar dados quando nenhum intervalo corresponde ao valor
Tipo de dado de saida
"

Float32

Raster reclassificado

C:fufabc/Dados_AnaliseEspadial (dasses_dedividade_sbe. tif




Calculadora Raster:
Algebra de mapas & Reclassificaco

Classe

Oa5graus = 1

5a30graus= 2

>30graus = 3

4| Tabela de redassificacio
Minirno Maximo Valor Adicionar linha
1 D 3 1 Remover linha(s)
2 3 30 2 Remover Tudo
3 30 180 3 OK
Cancelar




Calculadora Raster:
Algebra de mapas & Reclassificacdo

G! Propriedades da camada — classes_declividade_sbc — Simbologia

¥ Renderizacao da banda

rfi; Inf ) Tipo de renderizacao JPaletizado/Valores Unicos,
nformacdo

Banda Banda 1 (Gray)
| S
@ fonte Gradiente de cores Random colors
{fy Simbologia Valor Cor Rétulo

0

l..li Transparéncia

[ﬂ Histograma 1 :
/ -

& Renderizacio 5 ,

ﬁ' Temporal

‘ Pirdmides

- I Elevagao

E Metadados




Calculadora Raster:
Algebra de mapas & Reclassificacdo

v [»] 2 classes declividade sbc
Banda 1 (Gray)




Dados Vetoriais:
Operacoes Geograficas

v Agregacao

v Soma

v Interseccao

v Diferenca

v Atribuir Dado por Localizacao
v Criacao de Buffers



Operacoes Geograficas

Agregacao (Dissolve)
Elimina divisdes indesejadas através dos valores de
atributos.

Entrada Saida

>

Exemplo: A partir da malha censitaria original do ABC,
crie uma malha de bairros.



Operacoes Geograficas

Agregacao (Dissolve)
Gerar um mapa dos bairros de Santo André, Sao Bernardo do

Campo e Sao Caetano a partir dos setores censitarios desses
municipios.

Para tanto, agregaremos os poligonos dos setores censitarios
tendo como referéncia a variavel “Cédigo dos bairros” (COD_BA)

E importante utilizer a informac&o do cédigo do bairro, e ndo o
nome do bairro, dada a existéncia de bairros diferentes com o
mesmo nome (por exemplo, “Centro”).



Operacoes Geograficas

Agregacao (Dissolve)
Importar o shapefile “ABC_SETORES CEM_WGS84 UTM23S”

tttttt

- . &
OCO0O0O0O |
clw e

Setores Censitarios:
SA, SBC, SCS




Operacoes Geograficas
Agregacao (Dissolve)

Vetor > Geoprocessamento> Dissolver

Vetor Raster BancodeDados Web Malha Proc

Geoprocessamento | Buffer...

Geometnas P % Hecortar.

Analisar » ‘.- Envoltarna convexa...
Inwvestigar P & Diferenca..
Gerenciar dados b ¢ Dissolver...

M - T -



Operacoes Geograficas

Agregacao (Dissolve)

) Dissolver

Parametros Log

Camada de entrada

|~ ABC_SETORES_CEM_WGS84_LTM235 [EPSG:32723]

B r i -l:: - T lw = Ta
HOEMds TEICDES SeIEdonadas

Dissolver campo(s) [opdonal]

P
LU OHE

P Parametros avancados

Dissolvido

_ﬂ
b 4

'!I'I

C:fufabc/Dados_AnaliseEspadial (bairros_ABC.shp

[]

-Gi Dissolver campo(s)

[] NOM_UF
[] CoD_ME
[ ] NOM_ME
[] CoD_ml
[ ] MOM_MI
[ ] COD_RM
[] NOM_RM
[] CoD_MU
[ NOM_MU
[] coDp_Di
[] NOmM_DI
[] CoD_SD

N OM _SD
OD_BA




Operacoes Geograficas

Agregacao (Dissolve)
Importar o shapefile “ABC_SETORES CEM_WGS84 UTM23S”
Vector > Geoprocessing Tools > Dissolve

Setores Censitarios: SA, SBC, SCS Bairros: SA, SBC, SCS



Operacoes Geograficas
Soma (Union) ~ Envada Saida

Combina layers diferentes -
i s,

~ <

Vetor Raster BancodeDadeos Web Malha Proo

Geoprocessamento  * [ Buffer..,
Vetor > Geometrias b ™ Recortar..
Geoprocessamento > Analisar b 7 Envoltdria convexa...
o~ Investigar » B Diferenga...
Uniao Gerenciar dados @ Dissolver..

Intersecdo ...
Diferenca simetrica...

Unido...




Operacoes Geograficas

Soma (Union)
Importar shapefiles “MUNICIPIO_SP”” e “ABC_MUNICIPIOS WGS84 UTM23S”

Unir: Municipios ABC + Municipio Sao Paulo




Operacoes Geograficas

Soma (Union) Municipios ABC + Municipio SP
L) Unido
Parametros Leg

Camada de entrada

L~/ MUNICIPIO_SP [EPSG:31983] ™ &ﬁ ﬁ.

Apenas feigdes selecionadas
Camada de sobreposicdo [opconal]

(.~ ABC_MUNICIFIOS WGS84 UTM23S [EPSG:32723] Al * %

Apenas feicdes selecionadas
b Parametros avancados
Uinido

C: fufabc/Dados_AnaliseEspacdal (ABC_SP.shp




Operacoes Geograficas
Soma (Union)
Municipios ABC + Municipio SP




Operacoes Geograficas

Intersecao (Intersect) & Cortar (Clip)

Diferenca entre os dois:
Atributos dos resultados.

Clip = Somente os atributos das feicbes de entrada estarao no
arquivo de saida

Intersecao = Atributos de todas as feicOes estarao no arquivo de
saida.



Operacoes Geograficas

e Cortar (Clip)

| Cortaum layer tendo como base a geometria
de outro layer.

+ Vector > Geoprocessing Tools > Clip
CLIP FEATURE

H‘.. Exemp’O: Vetor Raster Banco deDados Web Mal
_/'I | Utilizar os limites da Geoprocessamento * [ Buffer.
regido do ABC para Geometrias b} % Recortar..

\4

et recortar os

A s [ lancamentos
\}/ Imobilidrios do ABC
R



Operacoes Geograficas
Cortar (Clip)

l'.:;" FRecortar

Parametros Log

Camada de entrada
LanRes_85_13_RMSP_CEM_SIRGAS2000_UTM235 [EPSG:319¢ ~  [[1) % -
Apenas feicoes selecionadas
Camada de sobreposicao
[~ ABC_MUNICIPIOS WGS84 UTM235 [EPSG:32723] v D % -

Apenas feicoes selecionadas

Recortado

C: fufabc/Dados_AnaliseEspacial frecortado. shp e




Operacoes Geograficas
Cortar (Clip)

Tabela:
Somente atributos dos empreendimentos imobilidrios



Operacoes Geograficas

~ Entrada
Intersecao (Intersect)
Saida
Area de
Intersecgao

Vetor Raster Banco deDados Web Malha Proo

Geoprocessamento ¥ ™ Buffer..

Geometrias b % Recortar..

Analisar » ' Envoltdria convexa...
Investigar b & Diferenca..
Gerenciar dados » ' Dissolver...




E.’,! Intersecdc

Parametros Log

Camada de entrada
|~ ABC_SP [EPSG:32723] v D {:} -

Apenas feigdes selecdonadas

Camada de sobreposicdo

-~ ABC_MUNICIPIOS_WGS84_UTM235 [EP5G:32723] «| ) *E;} S

Apenas feigdes selecdonadas

Campos de entrada para manter (deixe vazio para manter todos os campos) [opconal]
0 campo(s) selecionado(s)
Sobreposicao de campos para manter (deixe vazio para manter todos os campos) [opconal]
0 campo(s) selecionado(s)
I Parametros avancados
Intersecao
iC: fufabc/Dados_AnaliseEspadal fintersecao.shp & || -




Operacoes Geograficas

Intersecao (Intersection)

R

Tabela:
Inclui atributos
das duas camadas




Operacoes Geograficas

Diferenca (Difference)

E 0 oposto da intersecao.

Enquanto a intersecao cria um novo layer a partir de
uma mascara, a diferenca elimina uma area especifica a
partir da mascara (drea de diferenca) e mantém os
atributos do layer original.

Tema de Entrada

5N

J

|

RL

Area de Diferenca

=

Saida

£

|
=




Operacoes Geograficas

Diferenca (Difference)

Ex.: Criar um shapefile dos empreendimentos residenciais
da RMSP, exceto os empreendimentos residenciais do

ABC. (excluir empreendimentos do ABC)

Vetor > Geoprocessamento > Diferenca

Vetor FRaster Banco deDados

Geoprocessamento P
Geometrias 4
Analisar 4

Inwvestigar 4

r

C

Web Malha Proc

Buffer...
Recortar...
Enveoltona convexa...

Diferenca...



Operacdes Geograficas - - |

Diferenca (Difference)

() Diferenca

Parametros Lag

Camada de entrada
LanRes_85_13 RMSP_CEM_SIRGAS2000_UTM235 [EPSG:3198 ~ | [ {} o
Apenas feicoes selecionadas

Camada de sobreposicio

[~ ABC_MUNICIPIOS_WGS84_UTM235 [EPSG:32723] ~| 3D

e

Apenas feicoes selecionadas
b Parametros avancados
Diferenca
C: fufabc/Dados_AnaliseEspacial /diferenca.shp & || .




Operacoes Geograficas

Diferenca (Difference)




Atribuir Dados por Localizacao

Exemplo:

Gostaria de saber o preco meédio dos lancamentos
imobilidrios por municipio (e outras informacoes
municipais).

Vetor > Gerenciar dados > Associar atributos por localizacao

Vetor Raster Banco deDados Web Malha Processamento  Ajuda
Geoprocessamento b | D Ny 7 ik E z

. k L W5 | A
Geometrias L —
. ] vl w
Analisar b —
, Investigar 4
| Gerenciar dados 4 Criar indices espaciais ... |
i g L v

T 0 Associar atributos por localizacio... E



Atribuir
Dados por
Localizacao

L Associar atnbutos por localizagao

Parametros Log

Unir com elementos em

LanRes_85_13_RMSP_CEM_SIRGAS2000_LTM235 [EPSG: 3198 f:,ﬁ

L%,

Apenas feigbes selecionadas
Caracteristicas (predicado geométrico)

interseccionam [ Sobrepdem

[ ] contém [ ] estdo dentro de
|:| igual |:| cruzam

|:| tocam

AD Comparar com

L~ MUNICIPIOS_RMSP_SIRGAS2000 [EPSG:31983] A~

g

. .
Apenas feicdes seledonadas

Campos a serem utilizados (deixe vazio para usar todos os campos) [opconal]

0 campo(s) seledonado(s)
Unido por tipo
Criar feicdo separada para cada feicdo correspondente (um-para-muitos)

|:| Discartar registros que ndo conseguiram ser unidos

Prefixo campo unido [opconal]

Camada unida [opconal]

C: fufabc/Dados_AnaliseEspacial fatributos_localizacao.shp




Atribuir Dados por Localizacao

Layer com informacdes dos pontos e dos municipios

Camadas E X
o« [l ® T &, ~6F A L

7] ® atributos localizacao 5'
[] ® diferenca + Aproximar para camada(s)
[] . intersecao Aproximar a Selecao

® recortado = Mostrar na vista geral

+ g

1 W Aec sp Mostrar contagem dos elementos
[] ABC_MUNICIPIOS.W @1  Mostrar etiquetas
L] MUNICIPIO_SP Frr e
L] . batrros ABC Renomear Camada
] ABC SETORES CEM W
[] #® reclassificacao L] Duplicar Camada
[] & morros |1. Remover Camada...
[] B MDE SBC_SIRGAS200 o
[] %" Declividade SBC Mover para _infernior

5 eclividade_
[] contagem - Abrirtabela de atributos



Atribuir Dados por Localizacao

Layer com informacdes dos pontos e dos municipios

G,", atributos_localizacao — Total de feigées: 16935, Filtrado: 16933, Selecionado: O — O >
/ - & 5V E @D PE =& E
PCMEDALIST PCMEDALIDD PCMEDALITD D 2 CD_GEQOCODM  NM_MUNICIP
1 1771 3502901 ARUIAFA,
2 6474 1771 3502901 ARUJAFA™,
3 R4T4 1771 3503901 ARUJAFA",
4 0R59 1771 3503901 ARUJAFA",
5 1771 3503901 ARUJAFA",
6 1771 3503901 ARUJAFA",
7 1771 3503901 ARUJAFA",
. L
£ >

- Mostrar todos os feigies




Atribuir Dados por Localizacao

Caixa de Ferramentas de Processamento ->
Amostrar valores do raster

Camxa de Ferramentas de Processamento

"'_E_H L) "

w - g "

amostrar

W L) Analise raster

Amuostrar valores do raster




Atribuir Dados por Localizacao

ﬂ Amostrar valores do raster

Parametros Log
Camada de entrada

1@ A

Apenas feigoes seledonadas

Camada raster

" Dedividade SBC [EPSG:31933] e

Prefixo da coluna de saida [opcional]

dedividade

Amostrado

C:fufabc/Dados_AnaliseEspadal fpontos_dedividade.shp




Atribuir Dados por Localizacao

Camadas

o @ @',T.E.;"_ITQ

&5 X

o pontos declividade
. preco_municipio #-
® atributos_localizacac
[] ® diferenca

] . intersecao

[] ® recortado
1 Il ABC_sP

O B ABC_MUNICIPIOS V
1 MUuNICIPIO SP

L] . bairros ABC L]
(1 Il Aec seTores cem | Ld
[ ] B reclassificacao

[ ] B morros

[] B MDE SBC_SIRGAS20 | =

o
:-:

Aproximar para camada(s)
Aproximar a Selecao

Mostrar na vista geral

Mostrar contagem dos elementos
Mostrar etiquetas

Copiar camada

Fenomear Camada

Duplicar Camada

Eemover Camada...
Mover para _inferior

Abrir tabela de atributos



Atribuir Dados por Localizacao

(.3 pontos_declividade — Total de feicdes: 1838, Filtr... — ] >

J o e LT E S D -
'CMEDALGT PCMEDALIDD PCMEDALUTD declividad )

1 AULL AULL ANULL | 9,204044342041...

2 AULL AULL NULL  6,389638900756...

3 MULL MULL WULL  6,347218990325...

4 AULL AULL ANULL 0,215061634778...

3 AULL AULL NULL | 4,739915370941...

b 3733 AULL NULL  3,317247152328...

7 3733 AULL NULL  3,317247152328...

g AULL 6aTr NULL | 5,379299640655...

n £ wanancceTie

€ >

- Maostrar todos os feigbes ., -



Estatistica Zonal

Caixa de Ferramentas de Processamento ->

Estatisticas Zonais Caixa de Ferramentas de Processamente [P X
¥ A (D | Ty,

v @ Analise raster
Estatisticas zonais da camada raster
Histograma zonal
v 4@ GRASS
“ Haster (r.")

P
4 rstats.zonal

v &
&
&




Estatistica Zonal

l'.:'.! Ectatisticas zonais

Parametros Log

Camada de entrada

|~ ABC_SETORES_CEM_WGS84 LTM235 [EPSG:32723) - &ﬁ % -

Apenas feicoes seleconadas

Camada raster

=" Dedividade SBC [EPSG:31983] v

Banda raster

Banda 1 (Gray) e
Prefixo da coluna de saida _q Estatisticas a calcular
Estatisticas a calcular [ ] Contagem

Media, 5t dev, Minimo, Maximo

Estatisticas Zonais

C: fufabc/Dados_AnaliseEspacial festatistica_zonal.shp




Estatistica Zonal

Camadas

o [ ® T &~ & L

.| estatistica zonal
® pontos_declivida
. preco_municipio
® atributos_localiz:
[] ® diferenca

[] . intersecao

[] ® recortado

O [l ABC_spP

[] ABC_MUNICIPIC
[] MUNICIPIO SP
L] . bairros ABC

[ 1 |2] ABC_SETORES Ci
[] B reclassificacao

[] @ morros

s

b |
[ E ]

AT

L
L

& X

Aproximar para camada(s)
Aproximar a selecao

Mostrar na vista geral

Mostrar contagem dos elementos
PMostrar etiquetas

Copiar camada

Fenomear Camada

Duplicar Camada

Eemover Camada...
Mover para _inferior

Abrir tabela de atnbutos



Estatistica Zonal

G estatistica_zonal — Total de feigdes: 2624, Filtrado: 262...

[l

L

— O

L}

R BT E QD

_mean _stdev _min _max =
1 12,23270757287... | 13,65463322254... 145,1417999267...
2 3,680423358724... 7,082837682716... 80,26467132568...
3 9,124993615293... 9,531333897451... 0,0003939286032... 66,11076354980...
4 13,08818799046... 8513164245103... 0,106729075312... 4647911071777...
5 10,34693828787... 7,.295742300542... 0,073420561375... 41,70367431640...
b 9,199209592928... 8.3155007497532... 0,0008317740310... 49,295135349304...
7 0 240644172808... 7001232801049... 0,022294310352... 43,99064636230...
2 3,060574461796... 4921791973203... 0,001260492019... 29,86275482177...
: E ACAAMACACAAA £ TAANEANATATA | A ARAAASANAREE AR CARCARIA1TA

- Mostrar todos os feicies




Conversao de vetor para raster

Baster Banco deDados  Web

:',E,_" Calculadora Raster...

Alinhar Imagens (Rasters)...

Analise
Projecoes
Mizcelanea
Extrair

Converter

Malha Processamento Ajuda

Ty

ﬂ%ﬁzlv

=% PCT para RGE...

Raster para vetor (poligonizar)...

5 Converter vetor para raster (rasterizar)...



L Converter vetor para raster (rasterizar)

Parametros Log

Entrada:
ABC_Municipios

Campo: _ S—— :
123 DEMS_DEMO b

D E N S_D E M O Um valor fixo para gravar [opdona

Unidades de tamanho “®** .
, . [ ] Queimar valor extraido dos valores “Z” da feicdo [opconal]

d € sdl d d. IUnidades de tamanho da saida

Unidades :

GeorreferenCIadaS Resolucdo Horizontal Largura

4k

Re S0 I u gé o Resolucdo Vertical fAltura
(horizontal e vertical):

extensdo de saida [opdonal]

4k

30 metros Mao definido g
ESCOI h er pasta e Atribua um valor "sem dados” espedficado as bandas de saida [opcional]
0,000000 =

nome para gravar

P Parametros avancados
Rasterizado
C:jufabc/Dados_AnaliseEspacial [densidade_demoarafica_raster. tif D




v 2 densidade_demografica_raster
Banda 1 (Gray]
11.601

1.014




Conversao de raster para vetor



Ly

(.} Raster para vetor (poligonizar)

Parametros Log

Camada de entrada

o densidade_demografica_raster [EPSG:32723] S

Mumero da banda

Banda 1 (Gray) -

Mome do campo a criar

DEMS_DEMO

IUsar 8-connectedness

b Parametros avancados
Vetorizado
C: fufabc/Dados_AnaliseEspacial /densidade _demografica_vetor.shp &3 D




@ densidade_demografica_vetor.

/FEBRIRBE =<
DENS_DEMO
1 9060

2 5882
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